
Customizing the text  
in the Toolkit workforce materials

Because each company is different, the Toolkit’s 
workforce materials have been designed as flexible 
resources that you can adapt and use in many ways to 
suit your needs. Below is a summary of things you 
need to know about customizing the workforce 
materials. 

The workforce materials are available to download free of 
charge at the website of the National Business Group on 
Health (www.businessgrouphealth.org). You can 
download the Microsoft® Word® file for each document 
and edit it as you see fit. To check the formatting, you 
can download the same material as a pdf.

There are embedded instructions and placeholder text that 
you will need to delete or adapt before you use the Word 
files. Specifically:

■	 �To help guide you in customizing the workforce 
materials, the Word files include instructions that 
are in italics with yellow highlighting (see example 
below). You will need to delete these instructions 
from the final materials you distribute to 
employees.

■	“�ABC Toy Company” is used as a fictional placeholder 
name. When you see the ABC Toy Company name 
or logo, it indicates a place to customize the 
workforce materials by inserting your 
organization’s name or logo (see example below).

■	 �The workforce materials also have fictional links to 
resources on the fictional ABC Toy Company’s 
employee website. These links are to other 
documents that are part of the workforce 
materials. These links are included because we 
found that people like having cross-references to 
other Toolkit workforce materials. They also liked 
knowing that they can access all of the Toolkit 
workforce materials in one place. An example is 
shown below.

■	 �Please keep in mind that many of the links in the 
workforce materials are real links to real resources 
on government or other websites. To help you 
distinguish the fictional links from the real links, 
the fictional links are marked with italicized 
instructions highlighted in yellow that tell you to 
adapt or delete them. An example is shown below.
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■	 �If you plan to have a web-based “home” for various 
Toolkit workforce materials, you can replace these 
fictional references to the ABC Toy Company 
employee website with the name of your own 
employee website. If you won’t have a web-based 
home for the Toolkit workforce materials, you can 
delete all references to the ABC Toy Company 
website and the links they include.

■	 �Some of the workforce materials have places 
marked for you to insert information that is tailored 
to your own organization. These places have sample 
text that refers to the fictional ABC Toy Company. 
You can either replace these placeholder 
references with information about your own 
organization or delete them. 

The workforce materials contain numerous links to 
selected websites. When we tested the workforce 
materials, we found that people like having 
information about additional resources. 

■	 �Many of the links are to specific resources on 
government sites, such as the website for the 
federal Agency for Healthcare Research and 
Quality. For a list of the links that are included  
in the workforce materials, you can visit the 
Communication Toolkit website (hosted by  
the National Business Group on Health at  
www.businessgrouphealth.org) and click Links. 
This page also has additional links to resources 
just for employers and unions. 

■	 �All website addresses (URLs) in the workforce 
materials are current as of March 2008. You will 
want to test these links and update them as needed 
before you distribute the materials.

�

Customizing the photos  
in the Toolkit workforce materials 

About half of the workforce materials include photographs 
to personalize the documents and add visual appeal. In 
testing, we found that these photos helped to make the 
information personally relevant. 

Photos, illustrations, and other visuals have a great 
impact on the materials, so it is important to select  
them carefully. The Toolkit development team selected 
photos that:

■	 �Are clear, simple, and uncluttered.

■	 �Are culturally diverse in terms of demographics  
and physical appearance.

■	 �Have poses, body language, and facial expressions 
that are appropriate to the message and situation 
they illustrate.

Beginning on page 5, this document has a photo 
gallery that shows each photo that was used in the 
workforce materials and tells where it was used.  
There are 18 photos, most of which are close-ups of 
people’s faces.

All photos are from the same source, istockphoto.com,  
a low-cost source of photos. These photographs are all 
watermarked with a label that says “sample photo.”  
These sample photos are included in the workforce 
materials to illustrate where and how photos might  
be used to enhance the materials. For legal reasons 
related to copyright and photo usage agreements,  
each organization that uses these stock photos from 
istockphoto.com must pay istockphoto.com to use them. 
The cost is less than ten dollars each. If you were to 
purchase all 18 photos in the photo gallery, the total 
cost would be $130.00.

If you want to use these specific images from the 
Toolkit’s photo gallery, we have provided instructions 
below about how to order them and replace the 
watermarked sample photo with the one you have 
purchased. 

In addition, in case you would like to look for other 
photos on your own, we have included the names of 
several other stock photo companies. 
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Directions for using photos from istockphoto.com 

1. Log onto istockphoto.com. 

Go to http://www.istockphoto.com. Once you are on 
the site, follow the “sign up” link that allows you to 
create an account.

2. Create an account for yourself — it’s free. 

Follow the instructions on the sign up page. You will 
have to:

■	 �Choose a Member Name. This will be your 
identity on istockphoto.

■	 �Enter a valid email address.

■	 �Enter the verification key.

3. �Purchase the number of credits you will need to 
purchase photos. 

Once you have created your account, you will need to 
purchase “credits” that can be exchanged for 
photographs; istockphoto uses the credit system to 
allow you to purchase photos from the site. Each photo 
is worth a certain number of credits (photos in the 
workforce materials require 5 credits each). The 
number of credits depends on the photo, its size, and 
its resolution. For every photo that you download, a set 
number of credits will be deducted from your account. 

To purchase credits, click on the link that says “Buy 
Credits.” You can find it on the top tab or in the left-
hand toolbar. You can buy credits online in increments 
of 10, 26, 55, 115, 300, or 600. For example, you can 
buy 10 credits for $13.00.

Click on the number of credits you wish to purchase 
and then click on “Add to cart”. During the checkout 
process, you will need to enter personal and billing 
information. You can pay for the credits by credit card, 
Paypal, or Google Checkout. 

Once you have purchased the credits, istockphoto will 
send a confirming email.

�

4. �Find the photo you would like to purchase. In the search 
bar, enter the image number or your keyword. 

Once you have purchased your credits, you can 
download the images shown in the photo gallery  
(page 5) or you can search for other images.

To download the pictures from the workforce materials, 
enter the image number in the search field where it says 
“keyword search.” The appropriate photo should appear.

To search for a different image, you can do a keyword 
search. Enter a term in the left-hand box. For example, 
you may want to find a picture of a woman sitting at  
a computer. Enter the keywords “woman at computer.” 
Apply any of the additional search options. For 
example, you may want to choose the file type as 
“photo.”

5. Download the image.

Once you find the image you would like to download, 
click on the photo and the photo will become larger.  
A list of sizes available for that specific file appears 
underneath the image. For the photos in the workforce 
materials, we used medium size (with 300 dpi 
resolution). Select the size you want and click 
“download.” 

A Content Licensing Agreement will open. This is a 
user-agreement for the photos that says how you can 
and cannot use the image. You have the option of 
selecting a Standard agreement or an Extended 
Agreement. Read these agreements carefully to see 
what restrictions or options may apply to your 
organization. For example, you may want to purchase  
a Multi-seat license for 50 credits under the “Extended 
License Option.” 

If you agree to the terms of the Content Licensing 
Agreement, click “Agree” and the final download page 
will open. Then, click “download” and you can save the .
jpg file to your computer. 

Please note where you save the file. You may want to 
create a folder called “Communication Toolkit images.” 
You may also want to rename the file to be more 
descriptive of the photo, such as “woman at computer”.
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Once you click this final download button, the credits 
will be deducted from your account. If your download 
fails for some reason, you have 24 hours to download 
this file again without being charged additional 
credits. 

6. �Remove existing photo in the workforce materials.

We have provided the workforce materials in Microsoft 
Word 97–2003 for easy use and adaptability. To replace 
the existing photo marked as “sample photo,” you will 
need to view the document in print layout. You can get 
to print layout by clicking the “View” tab and selecting 
“Print Layout.” Select the photo you want to remove by 
clicking on it and then hit the delete button.

7. Replace existing photo with new photo.

To insert the new photo into the document, click the 
“Insert” tab and select insert “Picture,” then select 
“From file.” Open the folder where you saved your 
images and select the photo to insert.

When the new photo is inserted, the Picture Toolbar 
will pop up. If it does not, you can find it at any time by 
clicking on the “View tab,” selecting “Toolbars,” and 
then selecting “Picture.”

8. Crop, resize, or rotate the new photo if necessary.

We have cropped or resized certain photos in the photo 
gallery to focus attention on a clean and simple image. 

Crop. Cropping the photo deletes background that you 
do not want in a photo. To crop the photo, select the 
photo by clicking on it. From the “Picture Toolbar,” 
select “Crop.” The mouse cursor will change to the 
“crop tool.” Use the cursor to move the margins of the 
photo until it shows what you want.  

Resize. If you want to change the size of the original or 
the cropped photo to fit the space in the materials, 
select the photo by clicking on it. Click on any corner 
of the photo and drag the cursor to resize the photo as 
needed. By clicking on the corner, you will keep the 
height and width ratio of the photo the same. You can 
resize a photo from top-to-bottom or side-to-side by 
clicking on the sides of the image and dragging the 

�

cursor, but the image may become distorted. It is best 
to use this type of resizing only for minor changes to 
the picture. 

Rotate. For some photos, we have rotated the image 
(“flipped horizontal”) to make sure the person is 
looking in the right direction (toward the text). Once 
the photo is cropped and sized to fit the space, you can 
flip or rotate it. To flip the photo, first open the  
Drawing Toolbar by clicking on the “View tab” and 
selecting “Toolbars,” then select “Drawing.” On the 
Toolbar, click “Draw,” select “Rotate Or Flip,” and then 
select one of the options.

9. Save your document with the new photo!

You will need to save your document after you insert  
the purchased photos. Go to the “File” tab and “Save 
As.” You may want to re-name the document to let you  
know that the photos have been added.

Other sources for stock photos

If the sample photos from istockphoto.com in the 
workforce materials do not suit your needs, you may 
want to try other sources for photos (other sources may 
have different terms of use for the photos and higher 
prices). Here are some companies we would suggest:

■	 �Punchstock (www.punchstock.com) 

■	 �Corbis (www.corbisimages.com) 

■	 �Getty Images (www.gettyimages.com)

■	 �Jupiter Images (www.jupiterimages.com)

■	 �Comstock Images (www.comstockimages.com) 
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Photo Gallery

The sample photos from the workforce materials are 
included in this photo gallery. Next to each sample 
photo, we include the original image, image number, 
size, file size, and number of credits that you would 
need to purchase these photos from istockphoto.com. 
We also indicate whether we changed the photo by 
cropping or rotating the image. Each photo costs less 
than $10. To buy all 18 photos in the gallery, you 
would need to purchase 90 credits.

�

Photos that appear in:  
Health information on the internet: A checklist to help you judge which websites to trust

Original image:

Changes: Cropped to remove some background 

Image #
Size:

3005288
Medium

File size:
Credits:

1.91 MB
5

Original image:

Changes: Cropped to focus on upper body  

Image #
Size:

4991528
Medium

File size:
Credits:

1.27 MB
5
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Original image:

Changes: Cropped to remove some background  

Image #
Size:

3452331
Medium

File size:
Credits:

1.13 MB
5

Photo that appears in:  
How do we know which types of health care work best? 

Original image:

Changes: Cropped very slightly 

Image #
Size:

2283707
Medium

File size:
Credits:

1.39 MB
5

Photos that appear in:  
Information about health care quality: What it is and where to find it  

Original image:

Changes: None

Image #
Size:

864008
Medium

File size:
Credits:

1.73 MB
5
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Original image:

Changes: Cropped to remove kitchen background  
and focus on faces  

Image #
Size:

3774291
Medium

File size:
Credits:

1.96 MB
5

Photos that appear in:  
How you can use information about health care quality to get better care: Seven examples   

Original image:

Changes: None

Image #
Size:

5058827
Medium

File size:
Credits:

1.61 MB
5

Original image:

Changes: Cropped to focus on faces  

Image #
Size:

5026088
Medium

File size:
Credits:

1.59 MB
5

�
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Original image:

Changes: Cropped slightly 

Image #
Size:

3924960
Medium

File size:
Credits:

1.77 MB
5

Original image:

Changes: Cropped to remove background 

Image #
Size:

1050344
Medium

File size:
Credits:

1.66 MB
5

Original image:

Changes: Cropped to get close up of patient  
and doctor 

Image #
Size:

4815294
Medium

File size:
Credits:

1.84 MB
5

Original image:

Changes: Cropped to focus on face 

Image #
Size:

5268281
Medium

File size:
Credits:

2.25 MB
5
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Original image:

Changes: Cropped to focus on face 

Image #
Size:

3764295
Medium

File size:
Credits:

1.26 MB
5

Photo that appears in:  
Tips for getting the care that works best for your condition 

Original image:

Changes: Cropped to focus on face 

Image #
Size:

5132276
Medium

File size:
Credits:

1.60 MB
5

Photos that appear in:  
Health information on the internet: A checklist to help you judge which websites to trust  

Original image:

Changes: Image flipped horizontally 

Image #
Size:

3004076
Medium

File size:
Credits:

1.77 MB
5
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Original image:

Changes: None

Image #
Size:

3967046
Medium

File size:
Credits:

1.62 MB
5

Original image:

Changes: None

Image #
Size:

1331510
Medium

File size:
Credits:

1.54 MB
5

Photo that appears in:  
A list of recommended websites that have trustworthy health information 

Original image:

Changes: Cropped to delete background 

Image #
Size:

4635566
Medium

File size:
Credits:

1.20 MB
5
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About the Communication Toolkit

This document is part of the Communication Toolkit: 
Using information to get high quality health care.
This Toolkit was developed to help employers, labor 
unions, and others frame and deliver messages to 
employees about the meaning and importance of 
evidence-based health care. This Toolkit was developed  
by the American Institutes for Research (Kristin 
Carman, PhD, Project Director), and McGee & Evers 
Consulting, Inc., with funding from the California 
HealthCare Foundation. 

To access the Toolkit, visit the website of the National 
Business Group on Health (www.businessgrouphealth.org), 
where you will find the following Toolkit resources:

■	 �Workforce materials to download and adapt for use 
with your employees. This collection of Microsoft 
Word documents is available for you to download 
free of charge and adapt to suit your needs. The 
documents have been tested with employees for 
comprehension and appeal. 

■	 �Documents that provide background and suggestions  
to help you communicate more effectively with your 
workforce about evidence-based care.

•	� Using the Toolkit to explain evidence-based health 
care. This document points out essential features 
of the workforce documents and gives tips on 
how to use them. A companion document, How 
to customize the Toolkit workforce materials: 
Technical help with text and photos, explains 
things to know about customizing the Microsoft 
Word documents and using the photos.

•	� Communicating with employees about evidence-
based health care: Communication challenges.  
This research report summarizes findings from
the research that was done to inform the 
development of the Toolkit. This research 
included focus groups and interviews with 
employees and others, and a national web 
survey of employees.
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